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Note pour les utilisateurs Mac
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chapitre. Pour une liste plus détaillée, voyez dans I'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acceés aux options de paramétrage
Outils > Options

Clic droit #+clic Ouvre un menu contextuel

Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches

F5 Maj+38+F5 Ouvre le Navigateur

F11 ¥+T Ouvre la fenétre Styles & Formatage
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Impression rapide

Cliquez sur l'icbne Impression rapide = pour envoyer le document entier a l'imprimante par
défaut définie pour votre ordinateur.

Vous pouvez changer l'action de l'icbne Impression rapide pour envoyer le
document & une imprimante définie pour le document au lieu de I'imprimante par
défaut de I'ordinateur. Choisissez Outils > Options >
Chargement/enregistrement > Général et cochez Charger les paramétres
d'impression avec le document (comportement par défaut).

Contréler I'impression

Pour mieux controéler l'impression, utilisez la boite de dialogue Imprimer (Fichier > Imprimer ou
Ctrl+P).

Imprirner
210mm (Ad)

Général |LibreD’|‘fice Calc | Mise en page |Gptions|

i Imprimante

EPSOM 5Stylus DX5000 Series
Microsoft KPS Document Writer

|I!Ef'|
T
RzEETr

Plage et exemplaires

297 mm

() Toutes les feuilles Mombre d'exernplaires |1 =

@ Feuilles sélectionnées

() Cellules sélectionnées Assembler I@ I@

Dont imprimer

@ Toutes les pages

() Pages |1-2

[C] Imprirer dans 'ordre inverse

Imprimer ] [ Annuler

Figure 1 : Boite de dialogue Imprimer

La boite de dialogue Imprimer a quatre onglets, dans lesquels vous pouvez choisir une variété
d'options, comme décrit dans les sections suivantes.
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Les options sélectionnées dans la boite de dialogue Imprimer ne s'appliquent qu'a
l'impression du document en cours.

Note Pour fixer les paramétrages d'impression par défaut de LibreOffice, allez a Outils >
Options > LibreOffice > Impression et Outils > Options > LibreOffice Calc >
Impression. Voir Chapitre 14 (Paramétrer et Personnaliser Calc).

Sélectionner les options d'impression générales

Dans l'onglet Général de la boite de dialogue Imprimer (Figure 1), vous pouvez choisir :
* [limprimante (parmi les imprimantes disponibles)
e quelles feuilles et pages imprimer, le nombre d'exemplaires, s'il faut assembler les
exemplaires multiples et s'il faut imprimer dans I'ordre inverse des pages
Sélectionnez le bouton Propriétés pour afficher une boite de dialogue ou vous pouvez choisir
I'orientation portrait ou paysage, quel bac de papier utiliser et la taille du papier & imprimer.

Dans l'onglet Options de la boite de dialogue Imprimer (Figure 2), vous pouvez choisir d'imprimer
dans un fichier (et non vers une imprimante) et de créer un seul travail d'impression comprenant
les multiples exemplaires du document (et non un travail d'impression pour chaque copie).

| Général | LibreOffice Calc | Mise en page | Options |

Options

Dﬂmprimer danz un fichier:

[] Créer des taches d'impression uniques pour les sorties assemblées

Figure 2 : Options générales d'impression

Imprimer plusieurs pages sur une seule feuille de papier

Vous pouvez imprimer plusieurs pages sur une seule feuille de papier. Pour ceci :
1) Dans la boite de dialogue Imprimer, sélectionnez I'onglet Mise en page (Figure 3).

| Général | LibreQffice Calc | Mise en page |Gption5 |

Mise en page

Pages par feuille |4 Izl :l. 2

COrdre

[] Dessiner une

de bas en haut, puis a droite
de haut en bas, puis 3 gauche
de droite 3 gauche, puis vers le bas

Figure 3 : Imprimer plusieurs pages par feuille de papier

2) Dans la section Mise en page, sélectionnez dans la liste déroulante le nombre de pages a
imprimer par feuille. L'apergu sur la droite de cette liste vous montre I'organisation des
pages au sein du document imprimé.

Si vous imprimez plus de deux pages par feuille, vous pouvez choisir I'ordre dans lequel
elles seront imprimées horizontalement et verticalement dans la feuille. Les images ci-
dessus et ci-dessous vous en montrent la différence.

Contréler l'impression



| Général | LibreOffice Calc |MiSE en page |Gptior15 |

Mise en page

Pages par feuille |4

Crdre

[ Dessiner une de gauche a droite, puis en bas

de bas en haut, puis a droite

de haut en bas, puis 3 gauche
[

Am Ademite 3 mmnclhs e s

3) Vous pouvez choisir de dessiner une bordure autour de chaque page ou non.

4) Cliquez sur le bouton Imprimer.

Sélectionner les feuilles a imprimer

En plus d'imprimer le document en entier, vous pouvez choisir d'imprimer des feuilles individuelles,

des séries de feuilles ou une sélection dans le document.

Plage et exemplaires

Dent imprimer

@ Toutes les pages
") Pages |1-2

[ Irnprirmer dans |'ordre inverse

) Toutes les feuilles MNombre d'exemplaires |1 -
@ Eeuilles sélectionnées
(1 Cellules sélectionnées Assermnbler Pk Mk

Figure 4 : Choisir quoi imprimer dans Calc

Imprimer une seule feuille :

1) Dans le classeur, cliquez sur I'onglet de la feuille que vous voulez imprimer.
2) Choisissez Fichier > Imprimer dans la barre de menus.
3) Dans la section Plage et exemplaires de la boite de dialogue Imprimer, cochez l'option

Feuilles sélectionnées.
4) Cliguez sur le bouton Imprimer.

Imprimer une série de feuilles :

1) Dans le classeur, sélectionnez les feuilles a imprimer.

a) Sélectionnez la premiére feuille.
b) Appuyez sur la touche Citrl.

c) Cliquez sur les onglets des feuilles supplémentaires.
d) Relachez la touche Ctrl quand toutes les feuilles désirées sont sélectionnées.
2) Choisissez Fichier > Imprimer dans la barre de menus.
3) Dans la section Plage et exemplaires de la boite de dialogue Imprimer, cochez I'option

Feuilles sélectionnées.
4) Cliquez sur le bouton Imprimer.

Imprimer une sélection de cellules :
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1) Dans le document, sélectionnez les cellules a imprimer.
2) Choisissez Fichier > Imprimer dans la barre de menus.

3) Dans la section Plage et exemplaires de la boite de dialogue Imprimer, cochez l'option
Cellules sélectionnées.

4) Cliguez sur le bouton Imprimer.

Attention Apres l'impression, pensez a annuler la sélection de votre série de feuilles. Sinon,
en cas de saisie toutes les feuilles seront impactées, ce qui n'est
vraisemblablement pas ce que vous souhaitez.

Utiliser des zones d'impression

Les zones d'impression ont plusieurs usages, comme imprimer uniquement une partie déterminée
des données ou imprimer des lignes et colonnes sélectionnées sur chaque page.

Définir une zone d'impression

Pour définir une nouvelle zone d'impression ou modifier une zone d'impression existante :
1) Mettez en surbrillance la plage de cellules qui compose la zone d'impression.
2) Choisissez Format > Zones d'impression > Définir.

Les lignes de délimitation des pages s'affichent a I'écran.

Vous pouvez vérifier la zone d'impression en utilisant Fichier > Apercu.

Astuce LibreOffice n'affichera que les cellules a l'intérieur de la zone d'impression.

Ajouter a la zone d'impression

Apres avoir défini une zone d'impression, vous pouvez lui ajouter des cellules supplémentaires.
Ceci permet d'imprimer plusieurs zones séparées dans la méme feuille, sans avoir a imprimer la
feuille en entier. Aprés avoir défini une zone d'impression :

1) Mettez en surbrillance la plage de cellules a ajouter a la zone d'impression.

2) Choisissez Format > Zones d'impression > Ajouter. Les cellules supplémentaires sont
alors ajoutées a la zone d'impression.

Les lignes de délimitation des pages ne s'affichent plus a I'écran.

La zone d'impression supplémentaire sera imprimée sur une page séparée, méme

Note Si les deux zones sont sur la méme feuille.

Supprimer une zone d'impression

Il peut devenir nécessaire de supprimer une zone d'impression définie, s'il faut imprimer la page
entiére par exemple.

Choisissez Format > Zones d'impression > Supprimer. Ceci va supprimer toutes les zones
d'impression définies dans la feuille. Une fois la zone d’'impression supprimée, les lignes de
délimitation de page par défaut s'afficheront de nouveau a I'écran.

Utiliser des zones d'impression



Editer une zone d'impression

A tout moment, vous pouvez éditer directement la zone d'impression, par exemple pour supprimer
ou pour re-dimensionner une partie de la zone d'impression. Choisissez Format > Zones
d'impression > Editer. Si vous avez déja défini une zone d'impression, la boite de dialogue Editer
les zones d'impression ressemblera a celle de la Figure 5.

Dans cet exemple, trois rectangles sont sélectionnés, séparés chacun par un point-virgule. Le
premier est délimité par les cellules A1 ($A$1) en haut a gauche et la cellule D8 ($D$8) en bas a
droite. Cliquez n'importe ol dans la zone de saisie de texte pour afficher la zone d'impression en
cours a I'écran, dans laquelle chaque rectangle a une couleur différente, comme Figure 6.

. . oA P FIN -
Aprés tout changement, cliquez sur l'icone Réduire a coté de la zone de saisie pour
I'affichage des rectangles avec leur nouvelle valeur.

Pour étendre & nouveau la boite de dialogue Editer les zones d'impression, cliquez une nouvelle

fois sur l'icbne Réduire .

Editer les zones d'impression 3]
Zone d'impression
|- défini par I'utilisateur - IZH 5A51:5D58;5B516:5C517,5G523:5H524 L& |
_ | Annuler |
Lignes a répéter
|- aucun - IZ” (&1 | Aide |
Colonnes & répéter
|- aucun - IE” (o]
Figure 5 : Editer une zone d'impression
A | B [ D E [ F G H 1 J K [ L [ M
% c - Ié)ctalions Rafts Editer les zones d'impression @
anoes ateaux a
T'anv. 12 23 471 Zone d'impression —
| 4 [revr. 9 31 54 |- defini par rutilissteur - []] | SASL:5DS8:$B516:5C 517565 23:5HS 24 5]
5 |mars 14 27 56 Annuler
Iavr. 17 28 48 Lignes a répéter - I—I
| 7 |mai 13 19 39 60 - aucun - Aid
|8 liuin 8 27 52 | B = I;I
[ 9 | 50| Colonnes a répéter —
10 - aucun - [&]
I 40 | E| T
12
E 30 Rafts
| 14 | 20
| 15 |
| 16 | ‘ ‘ 10
| 17 |
18 0
(19 | janv. féwr. mars awr. mai juin
2o | —1
21
2]
| 38 |
| 24 |
25
6 .
Figure 6 : Zone d'impression avec rectangles de couleur
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Imprimer des lignes ou des colonnes sur chaque page

Si une feuille s'imprime sur plusieurs pages, vous pouvez paramétrer le fait que certaines lignes ou
colonnes se répeétent sur chague page imprimée.

Par exemple, si les deux premieres lignes, ainsi que la colonne A, doivent étre imprimées sur
toutes les pages, effectuez les opérations suivantes :

1)

2)

3)

Choisissez Format > Zones d'impression > Editer. Dans la boite de dialogue Editer les
zones d'impression, saisissez les lignes dans la boite de saisie de texte sous Lignes a
répéter. Par exemple, pour répéter les lignes 1 et 2, tapez $1:$2. Cela va modifier Lignes a
répéter de — aucun — a — défini par I'utilisateur -.

Pour répéter des colonnes, saisissez les dans la boite de saisie de texte sous Colonnes a
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier Colonnes a
répéter de — aucun — a — défini par I'utilisateur -.

Cliquez sur OK.

Vous pouvez également sélectionner les lignes ou colonnes a répéter avec la
souris. Pour ceci, positionnez le curseur dans la zone de saisie de texte

Note correspondante, puis sélectionnez dans la feuille la plage de cellules désirée. Il

n'est pas nécessaire de sélectionner des lignes ou colonnes entiéres : une cellule
de chaque ligne ou colonne suffit.

Editer les zones d'impression (3]

Zone d'impression
-
& ———

|- défini par I'utilisateur - IZ” 5451:5058:5B516:5C517:5G523:5H524

Lignes a répéter

- défini par I'utilisateur - |+ | S1:52 |@| [ Aide |

Colonnes a répéter

|' aucun - IZ” |§|

Figure 7 : Définir des lignes a répéter

Définir une zone d'impression personnalisée

En plus de mettre en évidence une zone d'impression pour chaque travail d'impression, vous
pouvez définir une plage de cellules qui sera utilisée régulierement. Ce peut étre utile si un
classeur important comporte différentes zones a imprimer pour différents rapports. Plusieurs zones
d'impression différentes peuvent ainsi étre définies pour répondre a ce besoin.

1)

2)

Pour définir une zone d'impression, utilisez la méme procédure que pour marquer une
zone de la feuille. Mettez en surbrillance les cellules que vous voulez définir en tant que
zone d'impression et sélectionnez Insertion > Noms > Définir. (Les cellules peuvent
également étre mises en surbrillance aprés l'ouverture de la boite de dialogue Définir un
nom.)

Dans la boite de dialogue Définir un nom (Figure 8), saisissez un hom pour la zone dans le
champ Nom. Le nom de la zone ne doit pas contenir d'espaces.

Utiliser des zones d'impression



Définir un nom |25

Definir le nom et la plage ou I'expression de formule,

Mo Zonelmprl
Plage SFeuillel.5A51:5058 | ]
Etendue Document (global) |E||

=I Options de plage

R E e ReTAE EERITE
Eiltre Répéter la ligne
Ajouter | | Annuler

Figure 8 : Boite de dialogue Définir un nom

3) Cliquez sur le bouton Options de plage et cochez ensuite I'option Zone d'impression.
Cliquez sur le bouton Ajouter.

4) Cette boite de dialogue permet également de définir un nom pour les plages de lignes ou
colonnes a répéter. Procédez comme ci-dessus pour les points 1 et 2 et cochez Répéter la
colonne ou Répéter la ligne selon votre besoin. Cliquez sur le bouton Ajouter.

Pour éditer cette zone :

1) Choisissez Format > Zones d'impression > Editer (Figure 5). La zone précédemment
définie apparait désormais dans la liste déroulante sous Zone d'impression. Les zones
nommeées de type Colonne ou Ligne a répéter figurent respectivement dans les listes
déroulantes correspondantes.

2) Sélectionnez la zone d'impression définie et cliquez sur OK.

Cette méthode peut étre utile pour changer rapidement la zone d'impression sans a chaque fois
mettre en surbrillance une grande zone de cellules.

Sauts de page

Si la définition de zones d'impression peut étre un puissant outil, il est parfois nécessaire d'ajuster
manuellement lI'impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un
saut de page manuel vous aide a vous assurer que vos données vont s'imprimer correctement.
Vous pouvez insérer un saut de page horizontal au-dessus de la cellule active, ou un saut de page
vertical & gauche de celle-ci.
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Insérer un saut de page
Pour insérer un saut de page :

1) Placez le focus sur la cellule ou le saut de page va commencer.
2) Sélectionnez Insertion > Saut de page.
3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors paramétré.

Saut de ligne

Saut de ligne va créer un saut de page au-dessus de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les lignes 14 et 15.

Saut de colonne

Saut de colonne va créer un saut de page a gauche de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les colonnes G et H.

Pour voir plus facilement les sauts de page a I'écran, vous pouvez changer leur
Astuce couleur. Choisissez Outils > Options > LibreOffice > Apparence et faites défiler
la liste jusqu'a la section Classeur.

Supprimer un saut de page
Pour supprimer un saut de page :

1) Placez le focus sur la cellule prés du saut de page a supprimer.
2) Sélectionnez Edition > Supprimer le saut de page.
3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors supprimé.

Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la méme
feuille. Si vous voulez les supprimer, vous devez supprimer chaque saut
individuellement (voir I'astuce suivante). Ce peut étre parfois difficile, car bien qu'il
puisse y avoir un saut de colonne paramétré dans la feuille, quand vous allez a
Edition > Supprimer le saut de page, le choix Saut de colonne peut étre

Note indisponible (grisé).
Pour supprimer le saut de page, vous devez étre dans la cellule a c6té de celui-ci.
Par exemple, si vous avez défini un saut de colonne alors que vous étiez en H15,
VOus ne pouvez pas le supprimer si vous étes dans la cellule D15. Cependant,
vous pouvez le supprimer depuis n'importe quelle cellule de la colonne H.

Vous pouvez également utiliser I'option Supprimer tous les sauts manuels du
Astuce menu contextuel si vous avez sélectionné Affichage > Apercu des sauts de

page.

Sauts de page



Paramétrage des options d'impression dans les styles de page

Plusieurs options d'impression sont paramétrées dans le style de page. Ce sont |'ordre des pages,
le choix des éléments de la feuille & imprimer et I'échelle pour l'impression. Parce que ces options
se trouvent dans un style de page, vous pouvez définir plusieurs styles pour modifier rapidement
les propriétés d'impression des feuilles d'un classeur. Voir Chapitre 4 (Utiliser les Styles et les
Modéles dans Calc), pour plus d'informations sur les styles de page.

L'onglet Feuille de la boite de dialogue Style de page (Figure 9) comporte les options suivantes :

Style de page: Par défaut ==
|Gérer |F‘age | Bordures |Arriére-plan |Er1-téte |P‘ied de page |FEIJi||E |
Ordre des pages
@ 0e haut en bas, puis vers |a droite! =
1 De gauche a droite, puis vers le bas f =
[¥] Premier numéro de page 1 = - -
Imprimer
[] En-tétes de colonnes/lignes [¥/] Diagrammes
[ Grille Objets de dessin
[] Commentaires [] Formules
Objets/Images Valeurs zéro
Echelle
Mode Echelle
|Réduiraa’agrandirI'impressiu:un |E|| Facteur d'échelle 100% =

| oK || Annuler || Aide || Réinitialiser

Figure 9 : Onglet Feuille de la boite de dialogue Style de page

Ordre des pages

Vous pouvez déterminer 'ordre dans lequel les pages vont s'imprimer. Ceci est particulierement
utile dans un grand document ; par exemple, contrbler I'ordre d'impression peut faire gagner du
temps si vous devez assembler le document d'une maniére précise.

Si une feuille s'imprime sur plus d'une page de papier, elle peut étre imprimée par colonne (la
premiére colonne de pages s'imprime, puis la seconde, et ainsi de suite) ou par ligne. Vous pouvez
vous aider de I'apercu en haut a droite de la boite de dialogue, comme Figure 9.
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Imprimer
Vous pouvez indiquez quels sont les éléments a imprimer. Ces éléments sont :

* Les en-tétes de ligne et de colonne
* Lagrille : imprime les bordures des cellules comme une grille

* Les commentaires : imprime les commentaires définis dans votre classeur sur une page
séparée, avec les références aux cellules correspondantes

* Les objets et les images

* Les diagrammes

* Les objets de dessin

* Les formules : imprime les formules contenues dans les cellules au lieu de leur résultat
* Les valeurs zéro : imprime les cellules avec une valeur de zéro

Echelle
Utilisez les fonctionnalités d'échelle pour contrdler le nombre de pages sur lesquelles les données
seront imprimées.

* Réduire/agrandir I'impression : met a un facteur d'échelle plus grand ou plus petit les
données dans l'impression. Par exemple, si une feuille s'imprime normalement sur quatre
pages (deux en hauteur et deux en largeur), un facteur d'échelle de 50 % établira son
impression sur une seule page (la largeur et la hauteur seront réduites de moitié).

* Adapter les zones d'impression en largeur et en hauteur : définit la hauteur et la largeur, en
pages, de l'impression.

* Adapter les zones d'impression au nombre de pages : définit le nombre exact de pages
qui seront imprimées. Cette option réduira uniquement l'impression, il ne lI'agrandira pas.
Pour agrandir une impression, I'option réduire/agrandir doit étre utilisée.

En-tétes et pieds de page

Les en-tétes et les pieds de page sont des morceaux de texte pré-définis qui sont imprimés en
haut et en bas d'une feuille, en dehors de la zone de feuille. Les en-tétes fonctionnent de la méme
facon que les pieds de page.

Les en-tétes et les pieds de page sont assignés a des styles de page. Pour plus d'informations sur
ces styles, voir Chapitre 4 (Utiliser les Styles et les Modéles dans Calc).

Paramétrer un en-téte ou un pied de page

Pour paramétrer un en-téte ou un pied de page :

1) Sélectionnez la feuille dont vous voulez paramétrer I'en-téte ou le pied de page.
Sélectionnez Format > Page.

2) Sélectionnez I'onglet En-téte (ou Pied de page).
3) Cochez l'option Activer I'en-téte.
A ce stade, vous pouvez également paramétrer les marges, I'espacement et la hauteur de I'en-téte

ou du pied de page. Vous pouvez cocher la case Adaptation dynamique de la hauteur pour
ajuster automatiquement la hauteur de I'en-téte ou du pied de page.
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Marges
La taille des marges gauche et droite ajuste la distance de I'en-téte ou du pied de page par
rapport aux cbtés de la page.

Espacement
L'espacement détermine la distance au-dessus ou en-dessous de la feuille a laquelle I'en-téte
ou le pied de page sera imprimé. Ainsi, si I'espacement est de 1 cm, il y aura un espace de 1
cm entre la feuille et I'en-téte ou le pied de page.

Hauteur
La hauteur représente la taille de I'en-téte ou du pied de page.

Style de page: Par défaut ==

|Gérer |F‘age | Bordures |Arriére-plan |En-téte |F‘ied de page |Feuille|

Contenu identique gauche/droite

Marge gauche 0,00cm =
Marge droite 0,00cm =
Espacement 0.25cm =
Hauteur 0,50cm =

Adaptation dynarmigue de la hauteur

| Pus. || Editen.,

| oK || Annuler || Aide || Reinitialiser

Figure 10 : Boite de dialogue Style de page - En-téte

Apparence de I'en-téte ou du pied de page

Pour modifier I'apparence de I'en-téte ou du pied de page, cliquez sur le bouton Plus, ce qui va
ouvrir la boite de dialogue Bordure / Arriere-plan.

Dans cette boite de dialogue, vous pouvez définir l'arriére-plan et le style des bordures de I'en-téte
ou du pied de page.
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Bordures |Arrigre-plan

Disposition des lignes Ligne Espacement avec le contenu
Par défaut Style A gauche 0,00cm =
I:l LI | IE” .-"l'adr-:uite 0,00cm =
Défini par I'utilisateur Largeur
0,05pt = En haut 000cm =
Couleur En bas 0,00cm =
|- Moir |E|| Synchroniser
Style d'ombre
Bosition Distance Couleur
(o ) o] ] 018cm |2 [ Gric

Figure 11 : Boite de dialogue Bordure / Arriere-plan de I'en-téte ou du pied de page

Paramétrer le contenu de I'en-téte ou du pied de page

L'en-téte ou le pied de page d'un classeur Calc comporte trois colonnes de texte. Chaque colonne
peut étre vide ou avoir un contenu différent.

Pour paramétrer le contenu de I'en-téte ou du pied de page, cliquez sur le bouton Editer de la
boite de dialogue de la Figure 10. La boite de dialogue de la Figure 12 s'affiche.

En-téte (Style de page: Par défaut) @
Zone gauche Zone centrale Zone droite
Auteur Feuille1 00/00/0000 00:00:00

[ Annuler l

BT

En-téte |Per5u:ur1na|i5é IZH

En-téte personnalisé REAEREEREIE)

Figure 12 : Editer le contenu d'un en-téte ou d'un pied de page

Zones
Chaque zone de l'en-téte ou du pied de page est indépendante et peut comporter des
informations différentes saisies par I'utilisateur ou insérées automatiquement (voir ci-apres).
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En-téte
Vous pouvez faire un choix parmi plusieurs possibilités pré-définies dans la liste déroulante En-
téte, ou définir un en-téte personnalisé comme dans la Figure 12 en utilisant les boutons ci-
dessous (pour formater un pied de page, les options sont les mémes).

En-téte personnalisé
Cliquez dans la zone (gauche, centrale ou droite) que vous voulez personnaliser, puis utilisez
les boutons pour ajouter des éléments et modifier les attributs de texte. Vous pouvez
€galement saisir un texte.

? Ouvre la boite de dialogue Attributs de texte.
% Insere le champ Nom de fichier.

L:J:' Insere le champ Nom de feuille.

E Insére le champ Numéro de page en cours.
[#] Insére le champ Nombre total de pages.
E Insére le champ Date.

@) | Insere le champ Heure.

Export au format PDF

Calc peut exporter les documents au format PDF (Portable Document Format). Ce format de
fichier standard est idéal pour envoyer un fichier a une autre personne qui utilise Adobe Reader ou
un autre lecteur PDF.

Export rapide au format PDF

=
Cliquez sur l'icéne Export direct au format PDF ™ pour exporter le document entier en utilisant
les paramétrages PDF par défaut. Vous devrez entrer le nom et I'emplacement du fichier PDF,
mais vous ne pourrez pas choisir un intervalle de pages, un taux de compression des images ou
d'autres options.

Controdler le contenu et la qualité du fichier PDF

Pour mieux contrdler le contenu et la qualité du fichier PDF résultant, utilisez Fichier > Exporter
au format PDF. La boite de dialogue Options PDF s'ouvre. Cette boite de dialogue comporte cing
onglets (Général, Vue initiale, Interface utilisateur, Liens et Sécurité). Effectuez les paramétrages
appropriés, puis cliquez sur Exporter. Vous devrez alors saisir I'emplacement et le nom du fichier
PDF a créer et cliquer sur Exporter pour exporter le fichier.

Général
Dans l'onglet Général, vous pouvez choisir quelles pages inclure dans le PDF, le type de

compression a utiliser pour les images (ce qui va affecter la qualité des images dans le PDF) et
d'autres options.
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Général |Vue initiale | Interface utilisateur |Liens | Sécurité

Plage Général
@ Tout! Incorporer le fichier OpenDocument
p Rend le PDF facilerent éditable dans LibreOffice
Pages
Sélection PDF/A-1a
Images POF marqué
@ Compression sans perte Créer un formulaire POF
Compression JPEG Format d'envoi —
Qualité A er les d e e cha
| Reduire la résolution des images 300 DPI E | Exporter les repéres de texte

Exporter les commentaires

| Incorporer les polices standards

Figure 13 : Boite de dialogue Options PDF - Onglet Général

Section Plage
* Tout : exporte le document entier si aucune zone d'impression n'a été définie ou le contenu
de ces derniéres dans le cas contraire.

* Pages :pour exporter un intervalle de pages, utilisez le format 3-6 (pages 3 a 6). Pour
exporter des pages individuelles, utilisez le format 7;9;11 (pages 7, 9 et 11). Vous pouvez
également exporter une combinaison d'intervalles de pages et de pages individuelles, en
utilisant un format similaire a 3-6;8;10;12.

* Sélection : exporte le contenu de la sélection en cours.

La section Plage est inactive (grisée) si I'option Incorporer le fichier

Note OpenDocument dans l'onglet Général est cochée.

Section Images
* Compression sans perte : les images sont exportées sans perte de qualité. Ce mode
peut produire des fichiers avec une taille importante si vous utilisez des photographies. Il
est néanmoins recommandé pour les autres types d'images et de graphiques.

e Compression JPEG : permet de faire varier le degré de qualité. Une valeur de 90 %
fonctionne bien avec les photographies (petite taille de fichier et perte de qualité peu
perceptible).

* Réduire la résolution des images : les images avec un DPI (dots per inch, points par
pouce) faible ont une faible qualité. Pour I'affichage sur un écran, une résolution de 150 dpi
est suffisante, alors que pour l'impression, il est généralement préférable d'utiliser au moins
300 ou 600 dpi, selon les capacités de I'imprimante. Des valeurs supérieures en dpi
augmentent considérablement la taille du fichier exporté.

Les images EPS (Encapsulated PostScript) avec des apercus incorporés sont
Note exportées uniquement en tant qu'apercus. Les images EPS sans apergus
incorporés sont exportées en tant qu'emplacements vides.
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Section Général

PDF/A-1a : PDF/A est un standard ISO pour la préservation des documents, en
incorporant toutes les informations nécessaires a une reproduction fidéle (comme les
polices) et en interdisant d'autres éléments (comme les formulaires, la sécurité ou le
chiffrement). Les repéres PDF sont écrits. Si vous cochez PDF/A-1a, les éléments interdits
sont grisés (indisponibles).

PDF marqué : les PDF marqués contiennent des informations sur la structure du contenu
du document. Ce peut étre une aide pour afficher le document sur des périphériques avec
plusieurs écrans, et lors de l'utilisation d'un programme de lecture d'écran. Les marques
exportées comprennent la table des matiéres, les hyperliens et les contréles. Cette option
peut augmenter la taille du fichier de maniere significative.

Créer un formulaire PDF — Format d'envoi : choisissez le format des formulaires a
I'intérieur du fichier PDF. Ce paramétrage écrase la propriété de contrdle de I'URL que
vous avez fixée dans le document. Il y a un seul paramétrage commun valide pour tout le
document PDF : PDF (envoie tout le document), FDF (envoie le contenu des contrdles),
HTML et XML. Le format PDF est le choix le plus ordinaire.

Exporter les repéres de texte : exporte le nom des feuilles des documents Calc en tant
que “reperes de texte” (une table des matiéres affichée par certains lecteurs PDF, dont
Adobe Reader).

Exporter les commentaires : exporte les commentaires des documents Calc en tant que
notes PDF.

Exporter les pages vides insérées automatiquement : indisponible dans Calc.

Incorporer les polices standards : vous pouvez choisir d'incorporer les polices Postscript
standards installées sur votre systéme (Times, Helvetica, Courier, Symbol, etc.) dans tous
les documents PDF créés par LibreOffice, pour améliorer la précision de l'affichage dans
les lecteurs PDF.

Vue initiale

Dans l'onglet Vue initiale (Figure 14), vous pouvez déterminer la facon dont le PDF s'ouvre par
défaut dans un lecteur PDF. Les options sont explicites.

Général |Vue initiale | Interface utilisateur |Liens | Sécurité

Mise en page
@ Par défaut
Repéres de texte et page Une page
Miniatures et page Continu
Quvrir 4 la page 1 = Qrientation continue

Agrandissement
@ Par défaut

Adapter 3 la fenétre
Adapter & la largeur
Adapter au visible

Facteur de zoom

Figure 14 : Boite de dialogue Options PDF - Onglet Vue initiale
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Interface utilisateur

Dans l'onglet Interface utilisateur (Figure 15), vous pouvez choisir plus de paramétres pour
contréler la fagon dont un lecteur PDF va afficher le fichier. Certaines de ces options sont
particulierement utiles si vous créez un PDF destiné a étre utilisé en tant que présentation ou
affichage de type kiosque.

Options de fenétre
* Redimensionner la fenétre selon la page initiale : la fenétre du lecteur PDF sera
redimensionnée pour pouvoir afficher la premiére page du PDF en entier.

e Centrer la fenétre sur I'écran : la fenétre du lecteur PDF sera centrée sur I'écran de

I'ordinateur.

* Ouvrir en mode plein écran : le lecteur PDF s'ouvrira en plein écran au lieu d'une petite
fenétre.

¢ Afficher le titre du document : le lecteur PDF affichera le titre du document dans la barre
de titre.

Général | Vue initiale | Interface utilisateur |Liens | Sécurité

Options de fenétre Opticns d'interface utilisateur
Redimensionner la fenétre selon la page initiale; Mazquer Ia barre de menu
Centrer la fenétre sur 'écran Mazquer I3 barre d'outils
Ouvrir en mode plein écran Masquer les contréles de la fenétre

| Afficher le titre du document

Transitions Repéres de texte

tiliser les effets de transition @ Tous les niveaux de repéres de texte

Miveaux de repéres de texte visibles

Figure 15 : Boite de dialogue Options PDF - Onglet Interface utilisateur

Options d'interface utilisateur
* Masquer la barre de menus : le lecteur PDF masquera la barre de menus.

* Masquer la barre d'outils : le lecteur PDF masquera la barre d'outils.

* Masquer les contréles de la fenétre : le lecteur PDF masquera les autres contréles de la
fenétre.

Transitions
Non disponible dans Calc.

Repéres de texte
Indigue comment les niveaux de titre sont affichés en tant que repéres de texte, si Exporter les
reperes de texte est coché dans l'onglet Général. Les Niveaux de repére de texte visibles ne
sont pas utilisés dans Calc, mais dans Writer.
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Liens
Dans cet onglet, vous pouvez choisir la fagon dont les liens sont exportés en PDF.

Général | Vue initiale | Interface utilisateur |Liens |Sécurité

Exporter les reperes de texte comme destinations nommées!

Convertir les références de document en cibles PDF
Exporter les URL relatifs au systéme de fichiers

Liens entre documents
@ Mode par défaut

Chuwrir avec un lecteur de POF

Ouvrir avec un navigateur Internet

Figure 16 : Boite de dialogue Options PDF - Onglet Liens

Exporter les repéres de texte comme destinations nommeées
Si vous avez défini des noms de feuilles Calc, cette option les exporte en tant que “destinations
nommées” auxquelles les pages Web et les documents PDF peuvent étre liés.

Convertir les références de document en cibles PDF
Si vous avez défini des liens vers d'autres documents avec des extensions OpenDocument
(comme .ODT, .ODS et .ODP), cette option convertit le nom des fichiers en .PDF dans le
document PDF exporté.

Exporter les URL relatifs au systéme de fichiers
Si vous avez défini des liens relatifs dans le document, cette option exporte ces liens dans le
fichier PDF.

Liens entre documents
Définit le comportement des liens cliqués dans les fichiers PDF.

Sécurité
L'export au format PDF comprend des options pour chiffrer les fichiers PDF (afin qu'ils ne puissent

étre ouverts sans mot de passe) et appliquer des fonctions de gestion des droits numériques
(DRM).

* Siun mot de passe d'ouverture est défini, le fichier PDF peut étre ouvert uniguement avec
ce mot de passe. Une fois ouvert, il n'y a pas de restriction sur ce que l'utilisateur peut faire
avec le document (par exemple, lI'imprimer, le copier ou le modifier).

* Siun mot de passe d'autorisation est défini, le fichier peut étre ouvert par tout le monde,
mais ses autorisations sont restreintes. Voir Figure 18.

* Siun mot de passe d'ouverture et un mot de passe d'autorisation sont définis
simultanément, le fichier PDF ne peut étre ouvert qu'avec le mot de passe et ses
autorisations sont restreintes.

Les paramétrages d'autorisations ne sont effectifs que si l'utilisateur du lecteur

Note PDF respecte ces paramétrages.
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La Figure 17 montre la boite de dialogue affichée si vous cliquez sur le bouton Définir les mots
de passe dans l'onglet Sécurité de la boite de dialogue Options PDF.

Une fois que vous avez défini un mot de passe d'autorisation, les autres options de l'onglet
Sécurité (de la Figure 18) deviennent accessibles. Ces options sont explicites.

|Généra| |‘u'ue initialel Interface utilisateur |Liens|5l§curité |

Permissicn et chiffrement du fichier Irmpression
= : Mon autorisée
| Defnit 65 ot S Paste ] Faible résolution (150 dpi)

Pas de mot de passe d'ouverture défini @ Haute résolution

Le decument PDF ne sera pas chiffré Modifications

o e Mon autorizées
Mot de passe d'autorisation défini

Le document PDF aura des restrictions Insertion, suppression et rotation de pages

Remplissage de champs de formulaire

Inserticn de commentaires, remplissage de champs de
formulaire

@ Tout sauf extraire les pages
| Autoriser la copie de contenu

| Autoriser I'acceés au texte des outils d'accessibilité

Figure 17 : Boite de dialogue Options PDF - Onglet Sécurité

Definir les mots de passe @

Def. mot de passe d'cuverture
kR

Mot de passe

Confirmer k]

Def, mot de passe d'autorisation

Mot de passe

Confirmer

(le mot de passe peut étre vide)

Aide | [ oK ]| Annuler

Figure 18 : Définir un mot de passe pour chiffrer un fichier PDF

Exporter en XHTML

Calc peut exporter les classeurs en XHTML. Choisissez Fichier > Exporter. Dans la boite de
dialogue Exporter, entrez un nom de fichier pour le document exporté, puis choisissez XHTML
dans la liste Format de fichier et cliquez sur le bouton Exporter.

Exporter en XHTML
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Enregistrer en tant que pages Web (HTML)

Calc peut enregistrer les fichiers en tant que documents HTML. Utilisez Fichier > Enregistrer
sous et choisissez Document HTML, ou Fichier > Assistants > Page Web.

Si le fichier contient plusieurs feuilles, elles seront a la suite dans le fichier HTML. Des liens vers
chaque feuille seront placés en haut du document. Calc permet également l'insertion de liens
directement dans le classeur en utilisant la boite de dialogue Hyperlien.

Envoyer des classeurs par e-mail

LibreOffice fournit plusieurs facons rapides et faciles pour envoyer des classeurs en tant que
piéces jointes d'un e-malil, et ce dans l'un de ces trois formats : classeur OpenDocument (format
par défaut de LibreOffice), Microsoft Excel ou PDF.

Les documents ne peuvent étre envoyés depuis le menu de LibreOffice que si un

Note profil mail a été paramétré sur votre systeme.

Pour envoyer le document en cours dans le format OpenDocument :

1) Choisissez Fichier > Envoyer > Document par e-mail. LibreOffice ouvre votre client de
messagerie par défaut avec le classeur (*.ODS) en tant que piéce jointe.

2) Dans votre client de messagerie, entrez le destinataire, I'objet et tout texte que vous voulez
ajouter, puis envoyez I'e-mail.

Fichier > Envoyer > Envoyer par e-mail en classeur OpenDocument a le méme effet.

Si vous choisissez Envoyer par e-mail en Microsoft Excel, LibreOffice va tout d'abord créer un
fichier au format Excel, puis va ouvrir votre client de messagerie avec en piece jointe le fichier
* XLS.

De méme, si vous choisissez Envoyer par e-mail en PDF, LibreOffice va tout d'abord créer un
fichier au format PDF en utilisant les parameétres PDF par défaut (tels que si vous utilisiez le
bouton de barre d'outils Export direct au format PDF), puis va ouvrir votre client de messagerie
avec en piece jointe le fichier *.PDF.

Envoyer un classeur par e-mail a plusieurs destinataires

Pour envoyer un document par e-mail a plusieurs destinataires, vous pouvez utiliser les
fonctionnalités de votre client de messagerie, ou les fonctions de I'Assistant mailing de LibreOffice
Writer pour extraire des adresses mail d'un carnet d'adresses.

Pour plus de détails, voir Chapitre 10 (Imprimer, Exporter et Envoyer par e-mail) du Guide du
débutant.

Signhature numérique des documents

Pour signer numériquement un document, vous avez besoin d'une clé personnelle, également
appelée certificat. Une clé personnelle est stockée sur votre ordinateur et associe la combinaison
d'une clé privée, qui doit rester secréte, et d'une clé publique, que vous ajouterez a vos documents
guand vous les signerez. Vous pouvez obtenir un certificat auprés d'une autorité de certification,
gui peut étre une société privée ou une institution publique.
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Quand vous appliquez une signature numérigue a un document, une somme de contréle est
calculée a partir du contenu du document et de votre clé personnelle. La somme de contréle et
votre clé publigue sont enregistrées avec le document.

Par la suite, si quelgu'un ouvre le document sur n'importe quel ordinateur doté d'une version
récente de LibreOffice, le programme procédera au calcul de la somme de contrdle et la
comparera avec la somme de contrble enregistrée. Si les deux sont identiques, le programme
vous signalera que vous étes bien en possession du document original non modifié. De plus, le
programme peut afficher les informations de la clé publique du certificat. Vous pouvez alors
comparer cette clé avec la clé publique publiée sur le site web de l'autorité de certification.

Si quelgu'un change quoi que ce soit dans le document, cela cassera la signature numeérique.

Les systémes d'exploitation Windows possédent leurs propres fonctionnalités de validation de
signatures. Sur les systémes Solaris et Linux, ces fichiers de validation sont fournis par
Thunderbird, Mozilla ou Firefox. Pour une description plus détaillée sur la fagon d'obtenir et de
gérer un certificat et une signature de validation, voir “A propos des signatures numériques” dans
I'Aide de LibreOffice.

Pour signer un document :

1) Choisissez Fichier > Signatures numériques.

2) Sivous n'avez pas enregistré le document depuis la derniére modification, un message
apparait. Cliquez sur Oui pour enregistrer le fichier.

3) Apres l'enregistrement, la boite de dialogue Signatures numériques apparait. Cliquez sur le
bouton Signer le document pour ajouter une clé publigue au document.

4) Dans la boite de dialogue Sélection d'un certificat, choisissez votre certificat et cliquez sur
OK.

5) La boite de dialogue Signatures numériques apparait de nouveau, et vous pouvez ajouter
d'autres certificats si vous le souhaitez. Cliquez sur OK pour ajouter la clé publique au
fichier enregistré.

Si un document est signé, une icone ] est affichée dans la barre d'état. Vous pouvez double-
cliquer sur cette icone pour afficher le certificat.

Supprimer les données personnelles

Vous pouvez vouloir vous assurer que les données personnelles, les versions, les notes, les
informations masquées ou les modifications enregistrées sont bien supprimées des fichiers avant
de les envoyer a d'autres personnes ou de les exporter en PDF.

Dans Outils > Options > Sécurité > Options, vous pouvez paramétrer Calc pour qu'il vous
rappelle (vous avertisse) que le fichier contient certaines informations lors de I'enregistrement, de
I'envoi, de l'impression, de la signature ou de I'export au format PDF.

Pour supprimer ces données d'un fichier, choisissez Fichier > Propriétés. Dans l'onglet Général,
dé-cochez Utiliser les données d'identité et cliquez ensuite sur le bouton Rétablir. Les noms
utilisés dans les champs Créé le et Modifié le, ainsi que les dates de modification et d'impression,
vont étre effacés, la date de création va étre réinitialisée avec la date et I'heure courante, et le
numeéro de version va étre remis a 1.

Pour effacer les informations de version, choisissez Fichier > Versions, sélectionnez les versions
dans la liste et cliquez sur Supprimer. Ces informations de version sont également effacées si
vous enregistrez le fichier sous un nom différent.
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